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EXO Accountant’s Assistant
EXO Accountant’s Assistant
This training manual has been 
developed by the MYOB Enterprise 
Division - Professional Services Team 
for use in the delivery of training.

This manual uses a simple step-by-step 
approach to give you the skills and 
knowledge necessary to set up and use 
the EXO Accountant’s Assistant module.

This manual has been designed for the 
following MYOB product:

• EXO Accountant’s Assistant



EXO Accountant’s Assistant EXO Accountant’s Assistant
MYOB Australia Pty Ltd
ABN 13 086 760 198
Website: myob.com.au
MYOB NZ Pty Ltd
Website: myob.co.nz

Disclaimer
MYOB has carefully prepared this material but excludes (to the extent allowed by legislation) any direct or 
indirect liability arising from errors or omissions or from its use. Any case studies (including the application of 
particular accounting standards or legislation) are representative examples only, and will not directly apply 
to the user's own circumstances. They are not a substitute for professional advice. Users must check that 
third party materials, for example from the IRD and the ATO, are current at the time they are used.

Trademarks
MYOB®, MYOB Accountants Office®, MYOB AccountEdge®, MYOB AccountEdge® Network Edition, MYOB 
AccountRight™, MYOB AccountRight Standard™, MYOB AccountRight Plus™, MYOB AccountRight Premier™, 
MYOB AccountRight Enterprise™, MYOB Accounting™, MYOB Accounting Plus™, MYOB BusinessBasics™, 
MYOB CashBasics™, MYOB ClientConnect™, MYOB FirstEdge®, MYOB M-Powered®, MYOB M-Powered 
Services™, MYOB M-Powered Bank Statements™, MYOB M-Powered Invoices™, MYOB M-Powered 
MoneyController™, MYOB M-Powered Payments™, MYOB ODBC DeveloperPack™, MYOB ODBC Direct™, 
MYOB PowerPay®, MYOB Premier®, MYOB Premier Enterprise®, RetailManager®, Accountants Office®, 
AccountEdge®, Accounting Plus™, BusinessBasics™, ClientConnect™, FirstEdge®, M-Powered®, M-Powered 
Superannuation™, ODBC DeveloperPack™, ODBC Direct™, PowerPay® and Premier® are registered trademarks 
or trademarks of MYOB Technology Pty Ltd and their use is prohibited without prior consent. Ceedata, 
Solution 6 MAS and Xlon are registered trademarks or trademarks of Solution 6 Holdings Limited, a member 
of the MYOB group. 
Adobe®, Acrobat®, Acrobat Reader®, Adobe Reader®, PDF™, and PostScript® are trademarks or registered 
trademarks of Adobe Systems Incorporated. 
AddressBook, Apple®, iCal®, Macintosh®, and QuickTime® and the QuickTime logo are registered trademarks 
of Apple Inc. Mac and the Mac logo are trademarks of Apple Inc., used under licence. MobileMeSM is a service 
mark of Apple Inc.
Microsoft, Access, Excel, Internet Explorer, .Net Framework, Office, Outlook, Smart Tags, Windows and Word 
are registered trademarks or trademarks of Microsoft Corporation in the United States or other countries. 
Quicken® and QuickBooks® are registered trademarks of Intuit Inc. 4D Tools® is a registered trademark of 4D 
S.A. BPAY® is a registered trademark of BPAY Pty Ltd, ABN 69 079 137 518. CaseWare® is a registered trademark 
of CaseWare International Inc. FlexNet Connect® is a registered trademark of Flexera Software™ Inc. Google 
Maps™ card links included with permission. HandiLedger® is a registered trademark of HandiSoft Software Pty 
Ltd. POSTbillpay® is a registered trademark of the Australian Postal Corporation. SM2DGraphView Copyright 
2002-2008 Snowmint Creative Solutions LLC snowmintcs.com/. Sentry Spelling Checker Engine for Windows, 
copyright Wintertree Software Inc. Brio Intelligence and Hyperion Intelligence are trademarks or registered 
trademarks of Hyperion Solutions Corporation. Crystal Reports® is a registered trademark of Crystal 
Decisions, Inc. in the United States or other countries. MasterCard® is a registered trademark of MasterCard 
International Inc. VISA® is a registered trademark of Visa International Service Association. 
RightNow CX® is a registered trademark of RightNow Technologies Inc
Other products mentioned may be service marks, trademarks or registered trademarks of their respective 
owners.

© MYOB Technology Pty Ltd 2012. All rights reserved.
This material is intended only for MYOB Enterprise Solutions Business Partners and their customers. No part 
of this publication may be copied, reproduced, utilised, transmitted, or distributed in any form by any 
means—including photocopying, recording, mechanical, electronic or otherwise—by any other party without 
the prior written authorisation of MYOB Technology Pty Ltd.

Edition: 8.5 
© Copyright 2012 MYOB Technology Pty Ltd

 ii

http://myob.com/au
http://myob.com/au


© Copyright 2012 MYOB Technology Pty Ltd

 iii

Participants
This course is aimed at:
• Users of EXO Accountant’s Assistant.

Prerequisites
Basic PC experience is required.
Understanding of payroll processes and procedures.

Instructional method
The instructional method combines trainer-led demonstrations with hands-on student 
practice. You will work through a series of examples. Each unit concludes with a Review 
Task. 

Conventions used in this manual
• Objects such as buttons or icons that you must click or select are shown in bold.
• Information to be entered (typed in) is shown in bold and italics.
• Keyboard keys are shown as , , etc.

Screenshots in this manual are for illustration purposes only and may differ from those in 
the actual product due to configuration settings.
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Symbols used in this manuals

Symbol Name This symbol tells you... 

Practice task

Review task

… to complete a task to practice the skills you have 
just learnt, or as a review task at the end of the unit 
to consolidate what you have learnt.

Written Review task … to complete written questions to review the 
content covered in the unit.

Optional Challenge … to complete this task if you have finished early 
and are looking for an extra challenge.

Tip … about helpful tips

Note … to take note of an important message.

Warning … about potential problems to be aware of.

Important … to pay attention to an important notice.

New … where features are new for EXO Accountant’s Assistant.

Reference … where to go to find more information.

Skills Checklist … to tick off a list of skills that you have learnt 
during the unit.
© Copyright 2012 MYOB Technology Pty Ltd
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Objectives

Upon completion of this course you will be able to:

• Briefly explain the features of the Accountant’s Assistant

• Explain the licensing restrictions

• Make use of checkslists to complete an End of Period

• Make use of checklists to complete an End of Year

• Make use of checklists to complete a Tax Return

• Make use of checklists to produce financial reports

• Make use of checklists to complete data verification and identify taxation issues.
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Navigational & Function Keys

MYOB EXO Business can be navigated by keyboard or mouse, however a combination of 
both is generally used. The standard keyboard convensions for Windows are used, with a 
few MYOB EXO Business-specific options.

Windows Navigation Keys

TAB Moves from field to field, column to column

SHIFT+TAB Moves backwards from field to field, column to column

ENTER On open dialogue boxes, automatically select the OK 
button.

ARROW KEYS Moves around a grid, or up and down a list.

PAGE UP, PAGE DOWN Moves between the “sections” of some screens, such as 
moving from the invoice header to the body to the end.

ALT + (Underlined Letter) ALT key plus the underlined letter on a field label 
activates that function, e.g. ALT + N within a the debtor 
account screen creates a New Debtor.
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Introduction
This unit will provide an 
overview of the 
functionality available in 
EXO Accountant’s 
Assistant.
By the end of this unit, you will be able to:

List the three sections available in EXO 
Accountant’s Assistant

Use the Global Financial Period Setting

Explain the licensing restrictions

Creata checklist widget
 1
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Overview

The EXO Accountant’s Assistant module provides accountants and external advisors with 
an intuitive and easy-to-use portal to the accounting functions of MYOB EXO Business.

The EXO Accountant’s Assistant interface is divided into the following sections: 

Business Checklists
This section displays a set of dashboard widgets containing checklists for important 
accounting processes. 

Financial Review
This section contains a standard package of financial reports that show key metrics for 
business owners and external advisors. 

Systems Integrity
This section displays a set of checks against the EXO Business database and ledgers to 
ensure that the system is balanced and healthy. 

MYOB Accountants Assistant
© Copyright 2012 MYOB Technology Pty Ltd

 2



Unit 1—Introduction
N O T E
An “Overview for External Advisors” White Paper can be accessed from the EXO 
Accountant’s Assistant Help menu. This document provides an overview of key areas of 
the EXO Business system for accountants and externals advisors to familiarise themselves 
with the basic concepts and functions in EXO Business.

Global Financial Period Setting
The EXO Accountant’s Assistant includes a Financial Period dropdown list at the top of the 
interface:

This is a global setting that specifies the period to be used by all Dashboard widgets. 
Widgets set up to use this setting will automatically refresh when the Financial Period is 
changed.

N O T E
To use the Financial period in a Grid or Pivot widget, the SQL statement used by the widget 
must contain the relevant parameter: @CURRENT_GLPERIODSEQNO (General Ledger), 
@CURRENT_CRPERIODSEQNO (Creditors Ledger), @CURRENT_DRPERIODSEQNO 
(Debtors Ledger), @CURRENT_STKPERIODSEQNO (Stock Ledger). This can be entered from 
the Parameter list dropdown list on the widget’s SQL tab.

N O T E
To use the Financial period in a Clarity widget, the Clarity report displayed by the widget 
must have a runtime parameter with one of the following names: 
CURRENT_GLPERIODSEQNO (General Ledger), CURRENT_CRPERIODSEQNO (Creditors 
Ledger), CURRENT_DRPERIODSEQNO (Debtors Ledger), CURRENT_STKPERIODSEQNO 
(Stock Ledger). 

Financial Period
© Copyright 2012 MYOB Technology Pty Ltd
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Licensing

The EXO Accountant’s Assistant module can be run by a single user without the need for 
an additional licence. Licences must be purchased to allow more than one user to access 
it. 
The following restrictions apply when accessing the EXO Business system from the EXO 
Accountant’s Assistant: 

• Full access is available to key functions relating to the General Ledger. 

• Restricted access to the Debtors and Creditors screens is available. Basic details of 
Debtor and Creditor accounts can be edited but no transactions can be generated for 
them. 

• Read-only access to Stock item records is available.
© Copyright 2012 MYOB Technology Pty Ltd
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Checklist Widgets

The checklist widget displays a structured list of items to be checked off as part of a 
process. List items can be a simple note to perform a task, or they can link to an EXO 
Business menu procedure. 

Buttons are available at the bottom of the checklist tree. Selecting a node on the tree and 
clicking these buttons changes the node’s icon to indicate its status: 

- Not Started 

- In Progress 

- Completed 
- Requires Review 

N O T E
There are no options for the Requires Review status; however, it can be set by a stored 
procedure attached to the node. Refer to ‘Creating Checklist Widgets’ on page 6 for more 
information.

T I P
Node statuses can also be changed by right-clicking on a node. When right-clicking on a parent node, 
options to set the statuses of all child nodes are available.

Checklist Widget
© Copyright 2012 MYOB Technology Pty Ltd
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N O T E
Checklist widgets are currently available only in the EXO Accountant’s Assistant module, 
where they provide configurable checklists of accounting functions. 

Creating Checklist Widgets
N O T E

Contact your MYOB Implementing Partner if you do not have access to create widgets.

To create a new widget:

1 Select Setup Widgets from the Setup menu.

N O T E
Widgets can also be set up in EXO Business Config in the Admin > Dashboards > Setup 
Widgets section.

Set Up Widgets Menu
© Copyright 2012 MYOB Technology Pty Ltd
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2 Click the  button.

3 Enter a name for the widget.

4 Select the Refresh Frequency, which determines how often the data in the report is 
automatically refreshed.

5 Select the EXO Business module in which this widget should be available. Choose 
from:

Create a new Widget

• All

• EXO Business

• EXO Job Costing

• EXO Business Analytics

• EXO Business CRM

• EXO Accountant’s Assistant
© Copyright 2012 MYOB Technology Pty Ltd
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6 Select a Widget Type:

7 Specify what information the widget should display:

8 For Clarity widgets, select the Default Zoom Settings. This determines how large the 
report appears inside its frame.

9 Click Save.

Clarity Report Select this type to create a widget that displays a Clarity 
report.

URL Select this typ to create a widget that displays the target 
of a URL, e.b. a web page or a local file.

Pivot Table Select this option to create a widget that displays data in 
a pivot table.

Grid Select this option to create a widget that displays data in 
a standard ExoGrid.

Check List Select this option to create a configurable check list that 
allows you specify steps when they are not started, in 
progress, under review or completed. Refer to 
‘Configuring Checklist Widgets’ on page 9 for more 
information.

Form This is not a selectable option. This is solely used for 
system widgets that are hard coded.

Clarity Report Click on the  button to select a report file. Once a 
report is selected, this button opens a window to set 
any necessary report parameters.

URL Enter the URL to display into the URL field.

Pivot Table or Grid Enter an SQL statement to select the data to display into 
the SQL field. You can also add in URL links to allow user 
to have increased click through functionality. 

Check List With this type of widget another tab called Checklist 
Setup will appear. This allows you configure the check 
list that you are going to use. This is only currently 
designed to be used with Accountant’s Assistant.
© Copyright 2012 MYOB Technology Pty Ltd
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Configuring Checklist Widgets
Checklist widgets display of a structured list of steps, or "nodes". Each node is a separate 
item that can be checked off the list; nodes can be a simple note to the user, or they can 
link to an EXO Business menu procedure, which will open on the checklist widget display:

Buttons are available at the bottom of the checklist tree. Selecting a node on the tree and 
clicking these buttons changes the node’s icon to indicate its status:

- Not Started 

- In Progress 

- Completed 
- Requires Review 

N O T E
There is no button for the Requires Review status; however, it can be set by a stored 
procedure attached to the node.

Node statuses can also be changed by right-clicking on a node. When right-clicking on a 
parent node, options to set the statuses of all child nodes are available.

Checklist Widget Example
© Copyright 2012 MYOB Technology Pty Ltd
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When "Checklist" is selected for the Widget Type, a Checklist Setup tab becomes available:

To set up a checklist widget:

1 Add nodes by clicking the New Node button. To add a node that links to an EXO 
Business menu procedure, drag the procedure from the Procedures list onto the 
checklist.

2 The Checklist Node Edit window is displayed. Enter the following details for the 
node:

Checklist Widget Setup

Field Description

Procedure If the node links to an EXO Business menu procedure, 
the procedure's name is displayed here.

Caption Enter a name for the node. This name will appear on 
the checklist widget when it appears on a dashboard.

Parameters For procedures that require extra parameters, e.g. Run 
Clarity Report or Add Existing Widget, specify the 
parameters here.
© Copyright 2012 MYOB Technology Pty Ltd
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Help Text Enter a short description for the node here, explaining 
what its purpose is, or giving instructions on how to use 
it. This text will appear at the bottom of the checklist 
display when the  button is clicked.
Note: Any text that starts with www. or http:// will be 
displayed as a clickable hyperlink.

Field Name The statuses of all nodes are stored in the EXO Business 
database, in the table specified by the Checklist Status 
Table property on the Checklist Setup tab. The status 
for this node will be stored in the field you specify here. 
Once set, the field name cannot be changed.
Note: Field names must be unique - if you enter a field 
name that is the same as another node's field name, it 
will be prefixed with a number to make it unique, e.g. 
FIELD_1. If this node is deleted, the field will be 
removed from the database.

Status Validation 
Stored Proc Name

The node's status is usually controlled by the buttons at 
the bottom of the checklist widget; however, it is 
possible to use a custom stored procedure to set the 
node's status. This property specifies a stored 
procedure that will be run when the checklist is loaded 
or refreshed, when the node is clicked on, or when its 
status is manually changed to "Complete". This 
procedure must take in the parameters @CONTEXTID 
and @NODESTATUS, and return a new @NODESTATUS 
value, which must be one of:
-1 = Do nothing 
0 = Set the node’s status to “Not Started”
1 = Set the node’s status to “In Progress”
2 = Set the node’s status to “Complete”
3 = Set the node’s status to “Requires Review”
4 = Hide the node and any sub-nodes below it
If the stored procedure name you enter here does not 
already exist, a default procedure with the correct 
inputs and outputs will be created when the table is 
saved (checklist procedures are automatically prefixed 
with "CL_").

Expanded By Default If this option is selected, then all subnodes under this 
node will be displayed by default; if not, the node will 
be collapsed by default, so that its subnodes will be 
hidden until the + icon next to the node is clicked.
© Copyright 2012 MYOB Technology Pty Ltd

 11



EXO Accountant’s Assistant EXO Accountant’s Assistant
3 Click OK

T I P
Subnodes can be added under any node (including other subnodes). Select the parent node or 
subnode, and then click New Subnode or drag a procedure from the Procedures list onto the parent 
node.

Editing Nodes
Once added, nodes and subnodes can be edited by double-clicking on them or by selecting 
them and clicking the Edit Node button. It is also possible to re-order nodes and subnodes 
by dragging them drag them into a new position, or by using the Move Up and Move Down 
buttons.
Select a node and click Delete Node or press delete to remove that node and any sub-
nodes underneath it.

Storing Checklist Node Statuses
The Checklist Status Table property on the Checklist Setup tab specifies the name of the 
table in the EXO Business database that will store the individual statuses of each node in 
the checklist. The table name you enter here must be unique; it will be created when the 
table is saved (checklist tables are automatically prefixed with "CL_"). Once set, the table 
name cannot be changed. The table contains a field for each node in the checklist - field 
names for each are specified by the Field Name property on the Checklist Node Edit 
window.

N O T E
If a checklist widget is deleted, a message appears asking the user if they also want to 
delete the associated table as well as any associated stored procedures.

Context-Specific Checklists
Checklists appearing in the EXO Accountant's Assistant can be made context-specific to a 
particular period. A context-specific checklist saves the status of all nodes separately for 
each period; when a period is selected from the Financial Period dropdown on the EXO 
Accountant's Assistant, the checklist updates to show the node statuses for that period.
Select an option from the Context dropdown at the top of the Checklist Setup tab:

• None 

• GL Period 

• Debtor Period 

• Creditor Period 

• Stock Period 
© Copyright 2012 MYOB Technology Pty Ltd
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N O T E
If "None" is selected, the checklist widget will not be context-specific; otherwise it will be 
specific to the period for the selected ledger. When a checklist is context-specific, the table 
that stores checklist node statuses contains a separate line for each period.
© Copyright 2012 MYOB Technology Pty Ltd
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

List the three sections available in EXO 
Accountant’s Assistant

Use the Global Financial Period setting

Explain the licensing restrictions

Create a checklist widget
© Copyright 2012 MYOB Technology Pty Ltd

 14



© Copyright 2012 MYOB Technology Pty Ltd
Business Checklist
This unit will provide 
instruction on using the 
Business Checklists.
By the end of this unit, you will be able to:

Complete an End of Period checklist

Complete an End of Year checklist

Complete a Tax Return checklist
 15
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Overview

The Business Checklists section of the EXO Accountant’s Assistant displays a set of 
checklist widgets for important accounting processes. 
By default, checklists for the following processes are displayed: 

• End of Period 

• End of Year 

• Tax Return 

Each checklist represents the best practices recommended by MYOB for those processes. 
These checklists are all context-sensitive to the period selected from the Financial Period 
control.

Click on the  to mark an item in the checklist as “In Progress”. This indicates 
that the particular step has been started, but is yet to be completed.

Click on the  to mark an item in the checklist as “Complete”. This indicates 
that the particular step has been completed.
© Copyright 2012 MYOB Technology Pty Ltd
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End of Period - Debtor Ledger

The Debtor Ledger Checklist include the tasks that must be completed to close the 
Debtor’s ledger for the financial period.

Debtor Data Verification
This step allows you to check for any discrepancies on Debtors accounts, imbalances on 
invoices and that the Debtors Ledger balances with the Debtors control account. Any 
errors/discrepencies found should be corrected before closing off the Debtors ledger for 
the financial period.

End of Period Widget - Debtor Ledger Checklist
© Copyright 2012 MYOB Technology Pty Ltd
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Print Debtor Statements
1 From the Utilities menu, select Debtor Statements.

2 Open the Debtor Statements screen using the path outlined above or clicking on 

 from the End of Month screen.

3 Search the Statements. Click the advanced Search options button to provide 
additional searching features. You can filter using:

• Account numbers From and To

• Account balances

• Aged balances

• Include accounts with zero balances, credit balances, inactive status or where there 
is current activities regarless of the account balance

• Custom filter SQL. For example, if you wish to exclude account group 2 from the 
statement printing, you would enter accgroup <> 2 into the Custom Filter SQL field. 
Use the Append option to append the custom SQL filter statement to the default 
filters using an AND operation. Use the Replace option to replace the default filter 
with the custom SQL filter.

Debtor Statements Screen
© Copyright 2012 MYOB Technology Pty Ltd
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4 If you change the parameters, remember to click the Search button to update the 
returned details. Review the Transactions. Double-click on the relevant Debtor line 
to review transactions that relate to the statement.

5 Sort the Statements. Click on the column header of the Exogrid to sort as required. 
Statements will print based on this sort order.

6 Print Statements. Choose Print one (to print a single statement) or Print all 
statements.

I M P O R T A N T
Only the current statement or the prior month’s statement can be printed. It is 
recommended that Debtor Statements are printed prior to rolling the End of Period 

7 Mailshot. The Mailshot button can be used to streamline the way in which debtors 
invoices are sent.

• Email Mode. From the dropdown list, select how emails should be sent:

Debtors Statements - Mailshot

Disabled will prevent emails from being sent.

EXO SMTP will use the EXO Business SMTP server. 
(Recommended for large batches of emails.)

Default Email Client will use the user’s default email 
software.
© Copyright 2012 MYOB Technology Pty Ltd
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• Email body as plain Text. Select this option to restrict the text format of the email 
body to plain text, rather than HTML.

• Confirm each email onscreen. Select this option to display a confirmation message 
before sending each email.

N O T E
If the Confirm each email onscreen option is selected, a confirmation message will appear 
after the first email is confirmed, providing an option to send the remaining emails without 
confirmation.

• Printer URL. From the dropdown list, select the printer to be used for printed 
statements.

• CLE File. Specify the Clarity email template to be used for emailed statements.

• CLM File. Specify the Clarity mail merge template to be used for printed statements.

N O T E
If the Print option is selected for any debtor accounts and the CLM file is either missing or 
invalid, a warning message will be displayed.

lk

• Attachments. Specify any attachments to be sent with the emails.

• From the list of debtors select whether the statement should be sent via Email or 
Printed. This option will default to the settings in the Debtors Maintenance - Details 
2 - Statement Delivery setting.

• Click on the Go button to start the mailshot.
© Copyright 2012 MYOB Technology Pty Ltd
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End of Period - Creditor Ledger

The Creditor Ledger Checklist include the tasks that must be completed to close the 
Creditor’s ledger for the financial period.

Creditor Data Verification
This step allows you to check for any discrepancies on Creditor accounts, imbalances on 
invoices and that the Creditors Ledger balances with the Creditor control account. Any 
errors/discrepencies found should be corrected before closing off the Creditor ledger for 
the financial period.

End of Period Widget - Creditor Ledger Checklist
© Copyright 2012 MYOB Technology Pty Ltd
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End of Period - Stock Ledger

The Stock Ledger Checklist include the tasks that must be completed to close the Stock 
ledger for the financial period.

Stock Data Verification
This step allows you to check for any discrepancies in Stock accounts, e.g. invalid stock 
codes, that the total stock matches the sum of the total stock in each stock location. Any 
errors/discrepencies found should be corrected before closing off the Stock ledger for the 
financial period.

End of Period Widget - Stock Ledger Checklist
© Copyright 2012 MYOB Technology Pty Ltd
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End of Period - General Ledger

The General Ledger Checklist include the tasks that must be completed to close the 
General Ledger for the financial period.

Reconcile Bank Accounts
The bank reconciliation function in EXO Business has been designed so that accounting 
staff can manage the company bank accounts.
While most of EXO Business is a period based system, by its nature the bank reconciliation 
function is date based. It can be carried out at any time before or after the end of period 
procedures.
The reconciliation can also be carried out at whatever regular interval suits your business 
requirements (ie weekly, fortnightly, monthly). Generally the higher the number of 
transactions in your business, the more frequently the reconciliation should be carried out 
in order to highlight any issues. A separate reconciliation needs to be undertaken for each 
bank account that you operate.
Bank reconciliation can be run using either of the two following methods:

1 Manual. For working from a hard copy, or printed, version of your bank statement.

2 Electronic. For working from a .CSV (Comma Separated Values) file provided by your 
bank.

End of Period Widget - General Ledger Checklist
© Copyright 2012 MYOB Technology Pty Ltd
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Either of these methods will essentially go through the process of matching unreconciled 
transactions from the selected GL bank account (payments, receipts, banking batches, etc) 
with entries that appear on the statement provided by your bank. You will be able to add 
extra transactions for bank fees and process any automatic payments (direct debits) 
received.

N O T E
You can use the reconciliation process on any of the General Ledger accounts. 
Reconciliations can be carried out on multiple GL accounts concurrently.

Once all items from the bank have been matched with those in the GL bank account, any 
remaining unreconciled transactions in the GL Bank Account should represent the 
difference between the balance of the GL bank account and the bank’s closing balance.
You can run either or both methods of reconciliation for the one bank account (e.g. 
manual or electronic).

Review existing Bank Reconciliations
Utilities > Bank Reconciliation
Open the Bank Reconciliation Utility . This starts the Finance module and opens the 
reconciliation utility.

1 Choose the bank account you wish to review from the GL bank account drop down 
list.

2 Search previous reconciliations. Click Search to show a list of previous 
reconciliations (these will appear automatically if the Auto Load option is selected). 
Previous reconciliations can be edited if your profile allows.

3 Review and/or edit previous bank reconciliation as required.

Bank reconcilation search screen
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Manual Bank Reconciliation
If you are not planning to edit or review an existing reconciliation, you can start a new 
reconciliation. The steps to complete a reconciliation are as follows:

1 Start a new reconciliation

2 Reconcile transactions

3 Add or remove transactions as required

4 Check the bank reconciliation

5 Print reconciliation report

6 Save the reconciliation

i) Start a new reconciliation:

1 Open Bank Reconciliation search screen via the path Utilities > Bank Reconciliation.

2 Start a new reconciliation by clicking New on the menu bar of the bank 
reconciliation search screen.

3 Enter the reconciliation details as follows:

• GL Bank Account (should default to the bank account chosen previously).

• Reconciliation Number - the system will provide this number as an increment from 
the last reconciliation number used. It can be changed (for example to the bank 
statement number) but cannot be the same as a number that has been used 
previously on this GL bank account. 

• Select unreconciled transactions up to and including. Enter the reconciliation date. 
For example: If, on the 11th March, you want to run a reconciliation for 4th March 
2011, key in the reconciliation date 4/03/2011 (or select from the popup calendar). 
The system will obtain the GL balance at 4th March and present unreconciled 
transactions up to and including 4th March ready for reconciliation.

New Bank Reconciliation
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• Date of closing bank statement: this is held for information purposes, to easily 
identify which statement file is being reconciled (for example, you may want to 
conduct two fortnightly reconciliations from the one monthly bank statement).

• Reconciliation type. In this example it is manual.

• Click OK to enter the setup information and the bank reconciliation details screen will 
appear.

ii) Reconcile transactions:

The left hand side of the reconciliation screen shows a list of the unreconciled 
transactions from the GL Bank Account. The right side of the screen shows transactions 
that appear on the bank statement.

N O T E
When using manual reconciliation, the transactions move from left to right when 
reconciled (e.g. we clear the left side). For CSV reconciliations the right side of the panel 
will be cleared.

1 Check the Bank Reconciliation header information. Most of these are set by the 
system and cannot be changed.

• GL Balance as at dd.mm.yy - Shows the GL balance at the date specified for the bank 
reconciliation.

• Reconciliation Type. Set to manual when starting the reconciliation. If you wish to 
change it, cancel out of this reconciliation and start again.

Bank Reconciliation Details
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• Locked: The reconciliation can be edited until the checkbox is ticked. When a bank 
reconciliation is complete we recommend that you ‘‘lock’’ it via this checkbox.

• Bank Statement Opening Balance: this is set to the closing balance from the previous 
reconciliation and cannot be changed unless it is the first reconciliation for this 
particular GL account.

• Bank Statement Closing Balance (at dd.mm.yy): is the opening balance plus all 
transactions that appear on the bank statement (i.e. those on the right hand side of 
the screen). Again this cannot be changed.

2 Reconcile transactions as required. To mark transactions as reconciled (ie to move 
to the right hand side of the reconciliation screen) either:

• Double-click on the item, or

• CTRL+Click multiple items and then click the  button on the toolbar.Press the 
Spacebar with the relevant transaction highlighted.

3 Unreconcile a transaction by Double-clicking on the item on the right side screen to 
move it back to the unreconciled (left side) screen.

Reconciliation Tools
There are some useful tools available to assist in running your bank reconciliation.

1 Search. To find transactions by cheque number or an amount .

2 Calculate Selected: to sum a series of selected transactions.

3 View Banking Batch: to view the batch a transaction belongs to (right click).

4 Exogrid. To reorganise how information is viewed in the grid.

5 Arrow Keys. To reorder transactions in the grid.

Search tool
Use the search function to assist in finding transactions from either side of the 
reconciliation.

1 Click the Search button on the toolbar. The search panel will appear above the 
reconciliation lists.

Search Panel
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2 Enter the search criteria and click Find.

• Cheque Number must be an exact match

• Amount is an absolute value (ie 100.00 will find either Positive or negative that 
amount).

• +/- provides the variance, so 100.00 +/- .50 will return values between 99.50 and 
100.50, as well as -99.50 and -100.50 (ie debits or credits).

• Details. Enter text to return any entries that contain the text specified here.

3 Transactions that match all of the search criteria will be highlighted in red and the 
total number of transactions found will be shown at the top of each column.

4 Hide the search panel by clicking on the Hide button when you have finished 
searching.

Calculate Selected Tool (F5)
The Calculate Selected function is useful for fast calculation of a series of transactions on 
either side of the reconciliation screen. This function may be useful if you have a series of 
receipts entered individually that have not been batched.

1 Select the transactions you wish to add by CTRL+Click. A tick will appear in the Sel 
column. 

2 Calculate the sum of the transactions by clicking on calculate Selected in the menu 
bar.

3 View the total at the bottom of each screen as shown above. 

4 Unselect the transactions by clicking on any other transaction.

Calculate Selected
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View Banking Batch
If the transaction you are reviewing on the reconciliation screen is part of a banking batch, 
right click on the transaction to view the banking batch it is part of.

Exogrid
The bank reconciliation screens are an Exogrid, and so can be sorted, columns removed or 
resized as appropriate.

Arrow Keys
As each item is reconciled, it is placed on the right hand side list in the order that it is 
reconciled. You may find it easier to move through the reconciliation with items placed in 
the order they appear on the bank statement. The up and down arrow keys located above 
the Bank Statement transactions list enable you to move transactions in the bank 
statement to a different Position on the list.

1 Click to select the transaction you wish to move. 

2 Click on the up or down arrow until the transaction is in the desired Position on the 
list.

iii) Add or remove transations:

Add Items to the Bank Reconciliation
The integrated cashbook feature of EXO Business is available from the Bank Reconciliation 
screen. It enables you to add transactions relating to bank fees, interest, foreign exchange 
accounts and other cash transactions which haven’t been processed by debtors or 
creditors.

1 Make a new cashbook entry. Select Tools > Make Cashbook Entry. The system will 
save any reconciliation information entered to date and take you to the Cashbook 
Entry screen.

2 Enter a new transaction by clicking new.

Most commonly your cashbook entry during processing of a bank reconciliation will either 
be X for Expense (bank fees), or I for Income (interest income).

Remove Items from the Bank Reconciliation
When two or more items in the list of unreconciled GL transactions balance each other 
out (ie, net to zero) they can be removed from the list of unreconciled GL transactions. 
This is useful when transactions have not appeared on the bank statement, even though 
they have gone through the GL bank account. For example, a payment received via credit 
card which did not go through correctly to the bank.

1 Select the transactions by Ctrl-clicking on each row. The transactions should be 
highlighted with the checkboxes ticked (for example, the original payment as well as 
the negative payment entry to reflect the fact that it did not go through to the 
bank).
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2 Select Tools > Remove From General Ledger. The transactions will be removed from 
the left hand side and flagged as ‘‘reconciled’’. They will not appear on the right 
hand side ‘‘Transactions appearing on the Bank Statement’’.

Remember, the transactions must net to zero. If they do not, the system will not allow the 
entry and will return a message ‘‘This function reconciles items on the same side of the 
ledger. Amounts must total zero to reconcile.’’

iv) Check the Bank Reconciliation
Tools > Check Reconciliation
When all reconciled transactions have been moved over to the ‘‘Items appearing on the 
Bank Statement’’ column, you need to check that the current reconciliation balances.

1 From the Bank Reconciliation screen, go to Tools > Check Reconciliation. 

2 Click OK to continue. If the reconciliation difference is zero, it balances and you can 
print the full bank reconciliation report. If not, you will need to check through the 
bank rec again to see why it doesn’t balance. Refer to ‘Common issues with Bank 
Reconciliations:’ on page 31 for some techniques to address an unbalanced 
reconciliation.

v) Create the Bank Reconciliation Report
Reports > Bank Reconciliation Details
Once the reconciliation is balanced, you should run and print the Bank Reconciliation 
Report.

1 From the Bank Reconciliation screen select Reports > Bank Reconciliation Details.

2 The system will produce the bank reconciliation Details report. 

3 Print the report using the Print button on the toolbar, or 

4 Save the report by using File > Save As. If you save it in a .CSV format, the data can 
be taken into a spreadsheet program for analysis.

Check Reconciliation screen
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vi) Save the Bank Reconciliation
Once your reconciliation balances and has been reported on, you should save the 
reconciliation. You can also save a partly completed reconciliation to work on at another 
time if required.

1 Save the reconciliation by clicking Save in the toolbar or File > Save.

If you do not want to save the reconciliation, click cancel to go back to the 
search/summary screen.

Common issues with Bank Reconciliations:
Bank Reconciliation doesn’t Balance
There are many reasons why a bank reconciliation may not balance. Listed below are 
some steps to follow if your reconciliation doesn’t balance.

1 Check that each transaction appearing on the bank statement has a matching item 
reconciled across from the GL on the right hand side of your reconciliation screen. (It 
may help at this point to use the arrow keys to organise the transactions in order on 
the right hand column as outlined in Reconciliation Tools earlier in this section.) 

2 Check each transaction amount matches that on the bank statement (e.g. a 
transposition error - $125.52 may be represented as $125.25).

3 Check that bank fees, interest, etc have been added.

Once you have gone through these steps you may need to use the following suggestions 
to address any other discrepancies.

Can’t find transaction in the GL list
1 Check the transaction date is within the range of the current bank reconciliation. 

2 Check that the transaction has been Posted to the GL via Post Creditors to GL, Post 
Debtors to GL. 

3 Check that the payment/receipt has been allocated to a purchase/sale.

Can’t Find Debtors Banking Batch in the GL
If a banking batch appears in the bank statement but not in the GL list:

1 Check that the batch has been Posted to the GL.

• Transactions > Debtors Receipts > Debtors Banking Batches

• Search for the banking batch (ie use date range, check the Branch, etc and click 
Search). If the GL column = N, then the batch has not been Posted to the GL.

• Open the batch and click the Post to GL button in the toolbar.
© Copyright 2012 MYOB Technology Pty Ltd

 31



EXO Accountant’s Assistant EXO Accountant’s Assistant
• Check the date on which the batch was Posted to the GL to ensure it is prior to the 
bank reconciliation date.

Banking Batch does not match Bank
1 Review the original accounts to check that the amounts have been entered 

correctly. You will need to check that each individual entry in the batch matches its 
corresponding remittance.

2 As a last resort, obtain a copy of the image from the bank to determine error. 

3 To correct any data error, go to the Transactions > Debtors Receipts > Debtor 
Receipt to enter a Positive or negative payment adjustment.

Creditor Payment does not match Bank
1 Review the original accounts to check that the amounts have been entered 

correctly. 

2 If a payment has been entered incorrectly reverse and re enter payment. 

3 If a Creditors adjustment is required, go to Transactions > Creditors Adjustments to 
enter an adjustment against the creditor using the appropriate predefined 
adjustment type (e.g Correction).

I M P O R T A N T
A Creditors or debtors adjustment should be a rare transaction not a common transaction.

Dishonoured Payments
If a payment has been dishonoured by the bank, then you can use one of the previously 
mentioned payment reversal methods to correctly reflect this change.
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Nominate Closing Rates
• Open the currency. Double-click on the relevant currency in the table and update the 

purchase rate and sell rate as appropriate.

Save updates. Click Save and open any other currencies for updating as required.

Post Forex Variances
1 Select the periods or dates to source the transactions from, using the Source Ledger 

Period / Date Range control. The four options available are:

• All unposted - All unposted transactions
• Prior to Current Period - Everything except the current financial period.
• Selected Period Range - Selecting this option lets you choose a From and To period 
to determine the source range.
• Selected Date Range - Selecting this option lets you choose From and To dates to 
determine the date range

2 Choose the Destination GL Periods for your Realised, Current and Unrealised Foreign 
Exchange Variances, this can be the source ledger period or it can be a custom GL 
period

Currencies Table
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3 Check for Unallocated Payments. Click on the Unallocated Payments Report on the 
menu bar. Since the allocation of payments is critical in running an accurate variance 
report, any unallocated payments should be addressed.

• Print the unallocated Payments report.

• Allocate any Unallocated Payments: using the appropriate allocation tools in the 
debtor/creditor accounts. 

• Re-run the unallocated payments report until all outstanding payments are allocated.

N O T E
Posting foreign exchange variances to the current period (0), the previous revaluation is 
reversed before a new auto-reversing journal takes place. When posting to a previous 
period (age 1), the existing valuations in age 1 are reversed and the new ones are entered 
for the period. These then auto-reverse themselves out in the next period, i.e. age 0. In 
addition to this any existing foreign exchange auto-reversals in age 0 are reversed out as 
well..

4 Use the Recalculate option to refresh the Foreign Exchange Variance Calculator.

5 Print the following Foreign Exchange reports::

• Creditors Gains/Losses Report

• Debtors Gains/Losses Report

• GL Accounts Gains/Losses Report

• Detailed Report

• Summary Report

6 Post to GL. Click post to GL to post the variance transactions to the General Ledger.

N O T E
 It is not possible to re-allocate a fully allocated foreign account transaction that has been 
part of a foreign exchange varience. Attempting to do so prompts the message “Cannot 
reallocate a fully allocated transaction that has been a part of Realised Forex Variance”.

Post Sub-ledgers to GL
The sub-ledgers in EXO Business can be posted to the GL separately, or all sub-ledgers 
(debtors, creditors and stock) can be posted together.
When ledgers are posted separately it is easier to review batches later on.

1 Ensure that the Debtors, Creditors or Stock ledgers are ticked. 
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2 Tick Exclude debtors payments if you do not want to post debtor payments. If 
debtor payments are posted then they can no longer be batched to facilitate the 
bank reconciliation. 

3 Enter posting details, including your initials and a description: 

N O T E
If you wish to post subledgers separately, tick only the ledger you wish to post at this time 
(e.g. Creditors only). The Debtor and Creditor subledgers offers further segregation. These 
options are controlled by user level profile settings . You will need to remember to post 
the other ledgers prior to rolling.

• Source Ledger Period. Debtor period that the transactions are being extracted from: 
and to:

• Destination GL Period: GL period to post to.

N O T E
To ensure that the ledger periods match leave the Destination GL Period as Source Ledger 
Period. This ensures that extractions from Period (X) are also posted to Period (X). If there 
is more than one source ledger period in the one extraction (ie aLL unposted), then there 
will also be multiple Destination GL Periods (unless you have specified a Custom GL 
Period).

4 Extract transactions. Click on View Unposted TRX to view any unposted debtor 
transactions from the specifed period without posting. Choose a particular period if 
required and then drill down on a transaction to view further detail.

5 Generate a preview of the post run by clicking on the button Preview GL Post Run. 
This will summarise and give you an opportunity to view the transactions without 
posting to the GL.

6 Generate a post run by clicking on the New GL Post Run button. This will create a 
suspended journal batch and mark the extracted transactions as posted, however it 
will not actually post them yet. A separate batch will also be created for each ledger 
and period, e.g. if you are posting the Debtors and Creditors ledgers for October and 
September, four batches will be created (Debtors - October, Debtors - September, 
Creditors - October, Creditors - September).
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7 The proposed batch can then be printed or edited. Right click on the Postrun name 
(Gl postrun #xx for GL period October 2012) to print or edit as follows:

• Description allows you to edit the postrun description 

• General ledger period allows you to change the period to which the transactions are 
posting.

• Fix imbalance. If the postrun is out of balance by a small amount (under a 
predetermined threshold) Fix imbalance will generate a rounding transaction. If the 
imbalance is larger than than the predetermined amount you will require a 
supervisor’s password.

8 Once the batch is balanced and you are satisfied that the data is correct you can click 
the Process GL post run icon in the toolbar to commit the suspended journal batch 
to the GL.

General Ledger Data Verfication
This step allows you to check for any discrepancies on GL accounts, that the GL account 
balances matches the transactional data. Any errors/discrepencies found should be 
corrected before closing off the General Ledger for the financial period.

Editing the GL Post Run batch
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Ledger Reconciliation
The Ledger Reconciliation provides an overview of the status of each ledger:

Sub-ledgers that are green are in balance with the related control account; red sub-
ledgers are not. The status of each sub-ledger is determined using the reconciliation 
reports (GL Payables Reconciliation, GL Receivables Reconciliation and Inventory Value 
Reconciliation). 
Each area of the report can be clicked on to drill to more information: 

• Clicking on a total for a control account opens the General Ledger Account Details 
window, displaying the relevant control account (Stock, Debtors or Creditors). 

• Clicking on the variance amount for a sub-ledger icon and the General Ledger icon 
opens the relevant Reconciliation Exceptions report. 

• Clicking on the total for a sub-ledger opens the relevant Reconciliation report. 

Check Trial Balance
The GL Trial Balance Tree is useful in creating a dynamic trial balance report, but it can 
also be used to review transactions, primarily by account and period range.
Once the trial balance tree is opened, click on the required account to open the 
transactions window for that account. You can then view the transaction details for each 
branch if required.

Ledger Reconciliation
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The Trial Balance Tree can also be useful for conducting a check of GST collected and paid 
to quickly determine the amount payable. 

1 Click on Current Liabilites and then  to view all the liability accounts.

2 Click on the GST Collected or GST Paid account and then click the  icon 
if you need further detail.

3 Click  to collapse the subaccounts and view only the main accounts.

Trial Balance Tree - Liabilities including GST Collected and GST Paid
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End of Period - Close-off

Print Financial Reports
From the Financial Review tab, select and print the necessary reports for end of period 
financial reporting.
Refer to Unit 3, ‘Financial Review’, on page 59 for more information.

End of Period
The period must be rolled so that transactions can be entered for the new period. Many 
organisations use a calendar month as a period, so the End of Period tends to be run at 
the end of each calendar month. If you have any queries about when to run End of Period, 
check with your accountant or implementation partner.
The End of Period, or roll-over, procedure ages the transactions (ie sets current period 
transactions (period 0) to previous period (period 1), ages the Debtor and Creditor 
balances and resets various cumulative month to date totals to zero.
Once the roll is completed, transactions can be entered for the new current period.

Separate Rolling of Ledgers
While we recommend that the four ledgers are rolled simultaneously, in certain 
circumstances it may be appropriate to roll the ledgers separately. For example, in a real-
time retail environment the Debtors and Stock ledgers must be rolled before opening of 
business on the first of the month. However you may also want to spend additional time 
finalising transactions in the Creditors and General Ledgers prior to rolling these ledgers.
If ledgers are rolled at separate times they will be ‘‘out of sync’’ with each other and extra 
care needs to be taken when processing and posting transactions. If you are not confident 
that you can manage disparate periods, the best practice is to roll all your ledgers at the 
same time and age any creditors and general ledger transactions back to the prior period.

I M P O R T A N T
Debtors and Stock Ledgers must be rolled at the same time. Creditors and General Ledger 
are generally rolled together.

To roll end of period

1 Open the End of Period utility (utilities > End of Period)
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2 Select the ledgers to roll (it is advisable to roll all ledgers together, however you may 
choose to roll them separately if required). At the very least, stock and debtors 
ledgers must be rolled at the same time.

3 Click OK to roll End of Period.

End of Period Outcomes
During the process, the system will:

• Take a snapshot of the data for use in EXO Business Analytics.

• Set period totals.

• Set month totals. 

• Copy aged balances to last period balances.

• Set aged balances. 

• Increment the transaction age. 

• Increment the allocation age. 

• Update the allocation statuses.

• Age the period status.

• Roll the period status.

• Re-values the unrealised gains/losses for the month and sets the closing rates.

Once this has been completed successfully you will be ready to commence entering 
transactions into the new current period.

Roll end of Period
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Lock Ledger Periods
This section displays the statuses of all accounting periods, showing whether they are 
currently locked or unlocked. 

It is recommended that financial periods that have been reconciled are locked to prevent 
transactions being posted to them in error or inadvertantly.

To lock a period:

1 Double-clicking the respective period in the relevant ledger. The lock icon will 
change from  to .

2 Click on the  icon.

To unlock a period:

1 Double-clicking the respective period in the relevant ledger. The lock icon will 
change from  to .

2 Click on the  icon.

All General Ledger transactions must be linked to a period. To verify that each transaction 
is associated with a period, click on the  button.

Period Statuses
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End of Year

The End of Year Checklist lists the items that should be completed at the end of a financial 
year.

Review Next Year Setup
Prior to completing an End of Year, it is important to ensure that the periods for the next 
financial year are set up in the system.

1 Click on the Next Year tab.

2 Click on the  button to copy the period definitions from the current year to 
next year.

3 If the periods are not calendar months, the Start Date and End Date must be 
reviewed for each period.

End of Year Checklist

Review Next Year Setup
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4 Click on the  button.

5 Make the necessary changes and click on the  button.

Setup Analytics Years/Months/Day Plan/Budgets
EXO Analytics and EXO CRM (additional modules) provide analytical reporting as well as 
sales management functionality. These modules require Years, Months, Days and Budgets 
to be set up for each financial year.

Setup GL Budgets
General Ledger budgets can be set up for the new financial year. Refer to the EXO 
Overview for External Advisors whitepaper available from the Help menu.

End of Period & Year
This process is similar to the End of Year process (Refer to ‘End of Period’ on page 39). 
Select the option End of financial year to indicate that this period is also the last period for 
the financial year. In addition to the end of period processes, the system will also:

• Move year-to-date totals into last year.

• Reset the year-to-date totals to zero.

• Clear Profit and Loss current year movements and post final balances to the Retained 
Earnings account.

Lock Ledger Periods
Similar to locking ledger periods after an End of Period, it is recommended that financial 
periods that have been reconciled are locked to prevent transactions being posted to 
them in error or inadvertantly.
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Tax Return - Tax by Rate Type 
Report

The Tax by Rate Type report shows the GST component of all Debtor and Creditor 
transactions by GST Rate.

Click on the Parameters tab to change the report parameters.

Tax by Rate Type Report
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Tax Return - Review Tax Returns

Previous Tax Returns can be viewed and edited.

To view or edit a previous Tax Return, double-click on the relevant Return. Once the 
relevant changes are made, click on .

Review Tax Returns
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Tax Return - New BAS Tax Return

The GST can be run on a period basis or a date basis, however we generally recommend 
using a period based GST as it reduces imbalances which can arise from transactions dated 
in a current period and posted to a prior period.
The data that is used for the GST Tax Return is based on the tax return key points set up 
when your database was implemented.
It is recommended that the following occurs prior to running the GST for a particular 
period:

• End of period process (including post Debtors, Creditors and Stock and checking of 
balances). See previous section End of period processes. 

• Bank reconciliation 

Business Activity Statement Procedure
1 Enter the GST header information & calculate entries

2 Reconcile GST report

3 Enter manual figures required

4 Print/Export the GST report

5 Save the GST tax return

6 Enter Payment/refund details

1. Enter the GST Header information and Calculate
1 Enter information into the Header tab as required.

• Tick Include Previous if you post transactions to prior periods that may not yet be 
included in a GST return. 
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• The Tax Return Code will be assigned to each transaction that is included when the 
GST is saved to ensure that they are only included in one GST return (e.g. Nov07).

N O T E
If you are using period based GST, the calculation will be based on the periods you specify 
on the right side of the screen, and the dates on the left are not referred to.

2 Click calculate in the toolbar to calculate the GST entries based on the period (or 
dates) and tax basis specified in the header.

3 Click Print to print a summary report of the GST return, or click the Summary tab to 
view on screen.

2. Reconcile GST
The GST needs to be reconciled against both the GST collected and GST paid accounts in 
the general ledger as well as the tax report by rate type report.

BAS Tax Return Header
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Run and print the tax report by rate type (path above).

Check that the totals provided in the Tax Report by Rate Type match the figures returned 
in the GST Summary.

If the figures do not match:

• Check that you are looking at matching periods/dates for both reports and rerun the 
reports. 

• If you have ticked ‘‘ Include Previous’’ in the GST header it will pick up transactions 
that have been posted to prior periods but have not yet been included in a BAS 
return. These will not be included in the tax report by rate type report.

Tax Return by Rate Type

BAS Summary tab
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• From the GST, click Source transactions in the toolbar to review the source 
transactions. As these are in an Exogrid you can sort by period to quickly see any 
transactions from prior periods.

• Alternatively to view source transactions from a particular key point, double click on 
that field (ie double click the field G1 to look at the source transactions that make up 
that amount).

• From the Source transactions screen you can generate a report or Export the details 
to a .CSV file for further review as required.

Reconcile against General Ledger accounts
Compare the GST payment/refund amount in the summary tab of the GST Tax Return (key 
point 9) against the GST Collected and GST Paid Accounts in the general ledger. Review 
the source transactions if there are any discrepancies.

3. Enter manual figures required
When reviewing the GST return, fields that are grey are computed fields while white fields 
enable you to enter additional figures which are then calculated by EXO Business into the 
GST return. Depending on your business these could include:

• Wine Equalisation tax

• Luxury car tax

• PAYG Instalment amounts

• FBT amounts, etc.

Source Transactsions G1
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Click on the relevant header tab to enter information as required. The following shows the 
PAYG Instalments tab as an example.

4. Print/Export the BAS Return
From the Summary tab, click Print or Export to print or export the BAS Return for your 
records and enter the details as appropriate into your formal return to be submitted.

5. Save the BAS Return
Click Save to save the return. This will mark the included transactions with the tax return 
code listed in the Header tab and exclude them from future BAS Returns.

6. Enter Recording Journals
Journal entries should be established to clear the GST collected and paid accounts to an 
GST clearing/ATO Payable account, as well as any other figures relating to PAYG Withheld, 
PAYG Instalments, etc.

PAYG Installment tab on the BAS Tax Return
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The following example shows the debit and credit entries of a simple transfer to the GST 
Clearing/ATO Payable account.

Using the simple example above, when payment is made to the tax office, the transaction 
would be as follows:

N O T E
At this point you may wish to lock the period/s for which you have just generated the GST. 
See your systems manager about locking past periods.

Account Debit Credit

GST Collected 11,961

GST Paid 21,708

PAYG Tax Withheld 7,625

PAGY Tax Instalment 5,5054

ATO Payable 2,932

Account Debit Credit

ATO Payable 3,536

Bank 3,536
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Tax Return - New NZ GST Return

The GST Return is run using the utility GST which is found on the Utilities screen or via the 

reports menu outlined above.
The GST can be run on a period basis or a date basis, however we generally recommend 
using a period based GST as it reduces imbalances which can arise from transactions dated 
in a current period and posted to a prior period.
The data that is used for the GST Tax Return is based on the tax return key points set up 
when your database was implemented.
It is recommended that the following occurs prior to running the GST for a particular 
period:

• End of period process (including post Debtors, Creditors and Stock and checking of 
balances). See previous section End of period processes. 

• Bank reconciliation 

GST Procedure
1 Enter the GST header information & calculate entries

2 Reconcile GST report

3 Enter manual figures required

4 Print/Export the GST report

5 Save the GST tax return

6 Enter Payment/refund details

1. Enter the GST Header information & Calculate
1 Open the GST Tax Return utility using the menu options outlined above or going to 

the Utility screen and clicking GST Tax Return.

2 Enter information into the Header tab as required.

• Tick Include Previous if you post transactions to prior periods that may not yet be 
included in a GST return. 

• Enter the Tax Return Code provided by the Inlard Revenue Department. The code 
details can be found at the top of the IR101a/IR103b forms. These forms are sent to 
you by the Inland Revenue Department. 
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• The Tax Return Code will be assigned to each transaction that is included when the 
GST is saved to ensure that they are only included in one GST return (e.g. Nov07).

N O T E
If you are using period based GST, the calculation will be based on the periods you specify 
on the right side of the screen, and the dates on the left are not referred to.

3 Click calculate in the toolbar to calculate the GST entries based on the period (or 
dates) and tax basis specified in the header.

4 Click Print to print a summary report of the GST return, or click the Summary tab to 
view on screen.

2. Reconcile GST
The GST needs to be reconciled against both the GST collected and GST paid accounts in 
the general ledger as well as the Tax Report by Rate Type report. If you have additional 
GST general ledger accounts, these must be included in the reconciliation.

GST Tax Return Header
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Run and print the Tax Report by Rate Type report (path above).

Check that the totals provided in the Tax Report by Rate Type match the figures returned 
in the GST Summary.

If the figures do not match:

• Check that you are looking at matching periods/dates for both reports and rerun the 
reports. 

Tax Return by Rate Type

GST Summary tab
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• If you have ticked ‘‘ Include Previous’’ in the GST header it will pick up transactions 
that have been posted to prior periods but have not yet been included in a GST 
return. These will not be included in the tax report by rate type report.

• From the GST, click Source transactions in the toolbar to review the source 
transactions. As these are in an Exogrid you can sort by period to quickly see any 
transactions from prior periods.

• Alternatively to view source transactions from a particular key point, double click on 
that field (ie double click the field G1 to look at the source transactions that make up 
that amount).

• From the Source transactions screen you can generate a report or Export the details 
to a .CSV file for further review as required.

Reconcile against General Ledger accounts
Compare the GST payment/refund amount in the summary tab of the GST Tax Return (key 
point 9) against the GST Collected and GST Paid Accounts in the general ledger. Review 
the source transactions if there are any discrepancies.

3. Save the GST Tax Return
Click Save to save the return. This will mark the included transactions with the tax return 
code listed in the Header tab and exclude them from future GST returns.

Source Transactsions G1
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4. Recording the IRD Payment/Refund
There are two methods that can be used for processing the payment/refund:

• Journal entry

• Creditors invoice

Using the IRD code for the IR101a/IR103b statement as the invoice number, enter the 
values to clear each account as per your IRD lodgement.
Alternatively, you can record journal entries to clear the GST collected and paid accounts 
to an GST clearing/IRD Payable account.
The following example shows the debit and credit entries of a simple transfer to the GST 
Clearing/IRD Payable account.

Using the simple example above, when payment is made to the tax office, the transaction 
would be as follows:

N O T E
At this point you may wish to lock the period/s for which you have just generated the GST. 
See your systems manager about locking past periods.

Account Debit Credit

GST Collected 11,961

GST Paid 21,708

Account Debit Credit

GST Clearing/IRD Payable 3,536

Bank 3,536
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Complete a Debtor Data Verification

Print Debtor Statements

Complete a Creditor Data Verification

Complete a Stock Data Verification

Complete a Bank Reconciliation

Complete a Ledger Reconciliation

Process an End of Period

Lock Ledger Periods

Process an End of Year

Complete a Tax Return
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Financial Review
This unit will provide 
instructions on using the 
Financial Review 
checklists.
By the end of this unit, you will be able to:

Produce financial reports
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Overview

The Financial Review section of the EXO Accountant’s Assistant contains a standard 
package of financial reports that show key metrics for business owners and external 
advisors. 

Reporting functions on the General Ledger Reports checklist include: 

• GL Trial Balance 

• General Ledger Graph 

• Export to Accountants Office 

On upgrading to EXO Business 8.5 or later, all General Ledger reports that are set up in the 
system are added as nodes to the General Ledger Reports checklist. In a new installation 
of EXO Business 8.5 or later, the default General Ledger reports are added. 

N O T E
Additional report can be added to the checklist. Contact the MYOB Implementing Partner 
to have additional reports added to the checklist.

Financial Review
© Copyright 2012 MYOB Technology Pty Ltd

 60



Unit 3—Financial Review
The Other Reports checklist include other relevant financial reports, such as:

• Debtor Aged Balances report

• Creditor Aged Balances report

• Stock Valuation report

Included is also an Export to Accountants Office option, which can be used to export 
information to MYOB Accountant’s Office.
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Print a General Ledger report

View the GL Trial Balance
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System Integrity
This unit will provide 
instructions on 
completing system 
integrity checks.
By the end of this unit, you will be able to:

Complete a Data Verification

Identify taxation issues
 63



EXO Accountant’s Assistant EXO Accountant’s Assistant
System Integrity

The Systems Integrity tab displays a set of checks against the EXO Business database and 
ledgers to ensure that the system is balanced and healthy. The following utilities are 
displayed by default: 

• Ledger Reconciliation 

• Data Verification 

• Tax Exceptions 
© Copyright 2012 MYOB Technology Pty Ltd
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Ledger Reconciliation

The Ledger Reconciliation utility provides an overview of the status of each ledger:

Sub-ledgers that are green are in balance with the related control account; red sub-
ledgers are not. The status of each sub-ledger is determined using the reconciliation 
reports (GL Payables Reconciliation, GL Receivables Reconciliation and Inventory Value 
Reconciliation). 
Each area of the report can be clicked on to drill to more information: 

• Clicking on a total for a control account opens the General Ledger Account Details 
window, displaying the relevant control account (Stock, Debtors or Creditors). 

• Clicking on the variance amount for a sub-ledger icon and the General Ledger icon 
opens the relevant Reconciliation Exceptions report. 

• Clicking on the total for a sub-ledger opens the relevant Reconciliation report. 

Ledger Reconciliation
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Data Verification

MYOB EXO Business includes a utility that performs various tests on the transactions in 
the EXO Business database to highlight any errors and suggest what may be causing them. 

The following options are available 

From the Source Ledger Period Range dropdown lists, select the From and To periods the 
verification is checked.
Click on Verify Data to run the utility. Click on Print to pring the result from the 
verification. The results can also be saved as a *.TXT file by clicking on Save As.

EXO Config Verification

Option Description

Verify Debtors
Verify Creditors
Verify General Ledger
Verify Current Invoices
Verify Allocations
Verify Misc Functions Stock

These options determine which aspect of the 
EXO Business system will be checked by the 
data verification process

Fix Current Aged Balances If this option is ticked, any imbalances in the 
current aged balances that are detected by the 
data verification process will be automatically 
corrected.

Only List Errors If this option is ticked, then the output results 
of tests that return errors- any tests that pass 
will not be listed.
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Tax Rate Exceptions

This utility can be used to help identify incorrect coding, or invalid codes.

This report can help identify tax rates set up or used on the incorrect ledger if changes are 
made to the tax rate settings. 
Chose to run the utility for Debtor transactions or Creditor transactions. You can also run 
the utility for a specific Date range or Period range.

Tax Rate Exceptions Utility
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Skills checklist
Tick the skills that you have learned in this unit.

Skills

Complete a Data Verification

Identify taxation errors
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